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Workshop Description, Goals, and Outcomes

This workshop will give you best practices and the skills needed to become a good
educational podcaster. During the workshop you’ll learn how to plan, produce,
encode and distribute your own audio podcasts. If time allows, we will also create
a simple video podcast.

Goals:

v’ Provide an overview of podcasting and its impact on professional
technical education.
v’ Plan, produce, encode, and distribute a podcast.

<

Identify the software and equipment needed for creating podcasts.

v Review copyright issues that apply to podcasting including using legal
music, images, and sound effects.

v" Make podcasts accessible to all students.

Outcomes:

Upon completion of this workshop, you will be able to:

v’ Use Audacity to record a podcast and convert it to MP3 file format with
appropriate compression.

Develop file naming and ID3 tag conventions to streamline your workflow.
Located copyright and royalty free music to include in a podcast.
Distribute a podcast using a blog and Feedburner.

Create a podcast transcript for ADA compliance.

AN N N NN

Find online resources that will help you answer your own podcasting
guestions in the future.

Workshop Web Site:

http://wec-podcasting.blogspot.com/
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8:00 — 8:45am
8:45 - 9:00am
9:00 - 10:30am
10:30-11:00am
11:00-11:30 am
11:30-12:00pm
12:00 - 1:00pm
1:00 - 2:30 pm
2:30 - 2:45pm
2:45—3:45pm

3:45 - 5:00pm
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Schedule

Breakfast and overview of day
Educational podcasting with examples
Record and edit podcast with Audacity

|”

Locate “legal” music and add to recording
Convert recording to MP3 and add ID3 tags
Best Practices discussion

Lunch and script development

Complete script and record podcast

Break

Edit and add music to podcast, convert to MP3

Create blog and podcast feed with FeedBurner
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4 Stages of Training
Stage 1: Unconscious and Incompetent
Stage 2: Conscious and Incompetent
Stage 3: Conscious and Competent

Stage 4:

What do you know? (Circle the correct answer)

1. You must have an iPod in order to be a T F ?
podcaster.
2. Studies have shown that students usually listen T F ?

to course podcasts on an iPod or MP3 Player.

3. If a podcast and its transcript are both T F ?
available, students will always listen to the
podcast.

4. It’s OK to use copyrighted music in your podcast T F ?

because it’s for educational purposes.

5. If you provide students with podcast lectures, T F ?
they will stop coming to class.

6. Apple has sold over 100 million iPods. T F ?

7. Hundreds of colleges and universities have T F ?
become iTunes Universities.
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1. What is a podcast?

PODCASTING

2. How do you find podcasts?

3. How do you listen to or view podcasts?

New Technology for Teaching and Learning
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How can podcasts be used in education?

v’ Distribute full or mini lectures

v’ Provide content review sessions

v’ Give practice exercises (foreign language, ESL, music)

v’ Interview interesting people

v Make class announcements

v’ Share industry news

v Record sounds important to an occupation (heart beats)

v Engage students in podcasting projects

v
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What are the potential benefits to students?

v’ Access for visually impaired or dyslexic students

v’ Appeals to auditory learners

v Mobility — take content anywhere

v’ Time shifting of content

v’ 24/7 availability

v’ Supporting tech savvy students

v
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Podcasting Process

Step 1 - Planning

Step 2 — Producing

Step3 — Encoding

Step 4 - Distributing
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Audacity Overview

Audacity is a free program that many podcasters use for recording their podcasts.
It is quite easy to use and has decent online support at
http://audacity.sourceforge.net/manual-1.2/index.html.

Audacity requires a helper file for converting recordings to MP3, the format used
for podcasts. The helper file is the LAME MP3 Encoder and you can download it
from http://lame.buanzo.com.ar/. The first time you use Audacity to export a

recording to MP3, you’ll be prompted to find a file named lame_enc.dll on your
computer. You only have to do this once!

Audacity Preferences

Before you record your first podcast, change the Audacity preferences using the
steps outlined below:

1. Open Audacity.

2. Select Edit = Preferences and click the Audio 1/0O Tab.

3. Make sure the Recording Device is properly selected for your microphone
and that Channels is set to 1 (Mono):

Audacity Preferences

Audia 140 lDuaIit_l,ll File Fu:urmats] Spectrngramsl Direu:tu:uries] Interface] Ke_l,ll:u:uaru:l] Mnuse]

Plavback

Device: |Miu:n:usu:uft Sound Mapper - Qutput j

R ecording

BT [ icrozoft Sound Mapper - lnput

Channels: | 1 [Mono]
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4. Click on the File Formats Tab and adjust the Bit Rate to 64 in MP3 Export
Setup towards the bottom of the screen. See below:

MP3 Export Setup

MP3 Library VYersion: LAME v3.96 Find Library |

Bit Rate: 64 I

File Management & Naming Recommendations

1. Use a convention for naming your podcast files. This insures the files are
displayed in a logical, easy to manage list on your students’ computers.

a. For example, you could name your course podcast for Business 101
bus-101 and the first episode recorded on April 18, 2008 would be
bus-101-2008-04-18.

b. Start with the Initials of the podcast program.

c. The year the podcast was created comes next and should always be
four digits.

d. The month the podcast was created follows the year and should
always be two digits.

e. The day the podcast was created is the final element and should
always be two digits.

f. NO spaces allowed in file names but dashes are okay!

g. In my experience it’s best to use all lower case letters in file names.

2. Use this convention for the files that Audacity creates when you record an
audio podcast.

3. Audacity saves the recording in a unique format that no other program can
open.

4. Audacity creates a master file, a back up file, and a folder with all the data
you recorded in your podcast.
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5. After exporting a recording to MP3, store the Audacity files in a separate
storage device since these files can be quite large.

Main Audacity Tools

Red circle to record

Time shift tool

Most Common Editing Procedures

1. Deleting unwanted portions of track — Select with Selection tool then click
the Scissors button or press Delete.

2. Adding silence — Use Selection tool to click in track where silence is desired,
then click Generate - Silence.

3. Increasing volume — It’s best to record at the proper level but you can
increase the volume when editing. Select the section that’s too soft then
click Effect - Amplify. Use the slider to increase or decrease the volume
then click OK.
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4. Removing noise — Select a section that has background noise (air

PODCASTING :: PRODUCING

conditioner hum, etc.) and select Effect - Noise Removal. Click Get Noise

Profile. Next select all the audio you want filtered and click Effect - Noise

Removal again. Adjust the slider for less or more (or leave it at the default

position) and click the Remove Noise button.

5. Normalizing — After you’ve edited your file, select Edit = Select - All.
From the Effects menu select Normalize. Accept the defaults. This will
soften plosives and make the recording sound better.

6. Bass Boost - Add some bass to make your voice sound richer. Select Edit =

Select - All. From the Effects menu select Bass Boost. Accept the defaults.

Adding music to your podcast

1. When you have finished editing your recording and have saved a music file

to add at the beginning of your podcast (called “bumper” music), click

Project - Import Audio. Select the music file and it will be placed on a new

track. See below:

x| audio Track ¥

Mono, 44100Hz
32-hit flost
Mute Solo

- +

&

1.0

X [Show_Time ¥

Stereo, 441 00Hz
32-hit flost

hiute Zala
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2. Select the Time Shift tool with your mouse then click and drag your voice
recording track to the right so that about 5 — 10 seconds of music will play
before you start speaking. See below:

%[ audio Track [ 1.0
Mono, 44100Hz 0s

+h
F2-hit float
Mute Sala 0.0
- +
8] 05
-0

X[show_Time [ 1.0
Stereo, 44100Hz | 05

32-hit float

Mute  Solo 0.0

- + 0.5
@ 1.0

ERRRG R s

045
0.0

-0.5
-1.0

o
-

3. Click on the Selection tool then drag it through the music track. Click Effect
-» Fade Out and the music track will look like the one below:

X [tudio Track w [ 1.0

Mono, 441 00Hz 0s
S2-hit float
hlute Sola 0.0
- +

Q) 08

X[Show_Time [ 1.0
Stereo, 44100Hz | 05
32-hit flost
hlute Sola
- + 05

)
L@Rm

4. Use the same tools and procedures if you want to use music in your outro
(called stinger music). This time you’ll be “fading the music in” instead of
fading it out, however.
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5. Music tips:

da.

b
C.
d

Use the same music in all your podcast episodes.

. Use a small amount, 5 - 10 seconds maximum.

Give the musician credit if required.

. Select music that you think your target audience will enjoy.
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Welcome to this Podcasting Workshop. I'm and I’'m using Audacity for the

first time. I’'m going to read this script so | can practice the editing tips we’re covering in our
workshop.

The first tip is to have a script and read it out loud before recording it. This is the best way to
improve the flow and readability of the text. And, it’s always a good idea to rehearse it a few
times before recording, if at all possible.

Here’s the second tip. Before you begin recording, check the level (or volume) of your
microphone. The wave form shouldn’t be as tall as the track nor should it be too flat. If the
loudest sounds you’re making go from -0.5 to 0.5, you’re probably at the correct recording
level.

Tip # 3. Click the Pause button, the one with the two blue vertical bars if you need to stop for a
few moments. Press the Pause button a second time to resume. Don’t click the Stop button
unless your recording is complete. If you click Stop then Record, a new track will be started
instead of continuing from where you left off.

The fourth tip. It goes without saying that you should find a quiet place for recording unless you
want extraneous noise in the background. This is rarely the case.

Tip # 5. Even with a script or detailed outline, it’s easy to mispronounce words or even
misspeak. If this happens, stop speaking for 3 or 4 seconds then repeat the problem section
starting from a logical place. When you’re editing the recording, you’ll be able to see the
section that needs to be removed because it will be marked by a flat line in the waveform.

The sixth and final recording tip. Remember to add some life to your voice and don’t speak too
quickly either.

Now for some editing tips. Tip # 1. You’ll notice that there are a few seconds of silence at the
beginning and at end of this recording. You want to remove the silence so let’s perform our first
Audacity edit now.

Here’s how. Go to the beginning of the track by clicking on the Skip to Start button. It’s on the
left of the Media controls section. Then use the selection tool to select the silence at the
beginning of the track, this is indicated by the flat wave form line, and press the delete key. Use
the Skip to End button to quickly jump to the end and remove the silence from it, too.

Tip #2. If you find it necessary to remove a very short piece of your recording, you can zoom in
on a section before deleting the sound. For example, you might have sneezed or coughed in the
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middle of a sentence. You want to get rid of the unexpected sound only. Use the selection tool

and click in the track near the sound you want to remove. Then click the ZOOM IN tool to make
it easier to select the sneeze. When you’ve gotten rid of the sneeze, click the ZOOM OUT tool
to go back to a normal view. Here’s a sentence to practice with.

One of the best things about podcasts is (sneeze) that you can listen to them at your
convenience.

Editing tip #3. If you include a lot of ums or ahs or other annoying speech habits when recording
without a script, you’ll want to delete them. Most of the time you’ll be able to identify a pattern
in the wave form for an um or ah making it easier to find. When you hear an um or ah, click the
Stop button. Use the Selection tool to highlight the sound. Press the space bar to play the
selection to make sure you’re deleting the part you want to get rid of. Remember you can zoom
in on the wave form which makes it easier to select the precise sound you want to remove.
Here’s a sentence to practice with.

Um the first time | um recorded without a script, | was ah shocked to um hear how many um
times | used ah and um in just one sentence!

Tip #4. It’'s best to spend time adjusting the volume before you start recording. But,
sometimes, your voice gets softer or louder and you want the level to be uniform. You can
adjust the volume by selecting the soft or loud section and then selecting Effect from the menu
bar and choosing Amplify. In the dialog box that appears, move the slider to the right or left to
increase or decrease the sound. Click the Preview button to hear the adjusted volume and
either accept it or adjust it again. Here’s a sentence you can practice with.

This sentence is spoken softly and the level needs to be increased. This sentence is spoken
loudly and the level needs to be decreased.

Finally, | want to give you an example of flubbing a phrase, pausing for 3 seconds then
repeating the sentence so the mistake can be fixed. Here are a couple sentences to practice
with.

People with vision problems or other types of disabilities like dylexia, (Pause for 3 or 4 seconds)

People with vision problems or other types of disabilities like dyslexia, appreciate being able to
listen rather than read.

Now it’s time to click the Stop button, save my recording file as an Audacity Project, and do
some editing.
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Converting to MP3 with Audacity

1. After you’ve completed all your editing and added bumper and
stinger music, select File - Export As MP3....

2. The Save As MP3 File dialog box opens letting you select a location
and new file name for the MP3 file. Make sure you note the location
of the file so you can find it again. And, if you’ve followed the file

naming convention suggested earlier, you won’t need to change the
name of the MP3 file.

Save MP3 File As: PIX

Save jn: |_}pudcasting ﬂ - i B

e
ky Recent
Documents

Dezktop

by Documents

L

e

by Computer
-
by M etwork, File name: |it'| 11-podzast-2003-04-01.mp3 j
Flaces
Save az hupe; | MP3 files [*.mp3] ﬂ Cancel

3. An Edit the ID3 tags for the MP3 file dialog box will open and should
be completed. See the next page for instructions.
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ID3 Tags are embedded into your MP3 file and they provide important information
about the file that is useful to people who will listen to podcasts on a computer, an
iPod or other MP3 player. ID3 stands for IDentify a MP3 and ID3v2 is the current

version.

Edit the ID3 tags for the MP3 file {Z_I ID3v2 will be selected automatically.

Format;

£ ID3v1 [more compatible] Title is the title of the episode.

{+ 1D 3v2 [rnore Aexible] Artist is the name of the person or group

responsible for the recording.

Title: |IT 111 'wieek 1 Podoast

Album is the title of the podcast series.
Artizt: |Jean Kent

Track Number can be left blank or use a

Alburr; ||T 111 Internet and Web Authoring using o )
number if it is logical.

Track Mumber: |1 ear: |2003 Year is the year the podcast was created.

Genre —Select “Speech” since Podcast isn’t

available.

Comments:
Comments is a place to add other information

Cancel | | ok | like the URL for the podcast web page.

| have found it helpful to make notes so that my ID3 tags are standardized for all my
podcasts.

Title:

Album:

Comments:
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Consider the learning outcomes you hope to achieve
with your podcasts.

"As with any educational technology, whether and how podcasting impacts the
quality of the learning experience and/or educational outcomes depends largely
upon how the technology is put to use." Ashley Deal, Office of Technology for
Education & Eberly Center for Teaching Excellence at Carnegie-Mellon University.

Paul McCloskey, "Consensus: Podcasting Has No 'Inherent' Pedagogic Value," Campus Technology,
7/9/2007, http://www.campustechnology.com/article.aspx?aid=49018

Best Practices

1. Podcast should be 2 — 10 minutes long, chunk content if
necessary.

2. Start with clear context for podcast content and end with most
important things to remember.

3. Create and use a script which will become the printed transcript
for accessibility.
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Script Production

Intro

1. Your name

2. Program name (e.g., IT 111 Podcast).

3. Tag line (e.g., Student Nursing News brought to you by the
NursingZone.com)

Outro

1. Quick review of important content
2. Tag line (e.g., Tune in next week for another IT 111 podcast.)

Music

1. RoyaltyFreeMusic.Com
(http://www.royaltyfreemusic.com/free)
2. PodsafeAudio.Com (http://www.podsafeaudio.com/)

3. The Freesound Project (http://freesound.iua.upf.edu/)

4. Create your own!

1. Create a script template in Word with your intro and outro and
use it for all your scripts.

2. Read script out loud then edit for flow.

3. Convert script to PDF and use as the transcript.

4. Rehearse completed script before recording.
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You have several options when it comes to distributing your podcasts.

1. Create a podcast page in your course web site or CMS/LMS account and
make a link to every podcast you create. See below:

) Faculty Development Podcast Archives - Mozilla Firefox

File Edit Wew History Bookmarks Tools Help  delcio.us

<’j - A @] ﬁ !; TAG ||_| http:,l’,l’dept.seattlecolleges.edu,ffd,l’Podcasts,l’ir| ‘| D’] "| |\]

> Podcast #32 (Posted on the FD Blog) February 11, 2007 18:30 minutes &
- Interview with Geoff Mathay conducted in June, 2006,

> Podcast #31 (Posted on the FO Blog) Decermnber 13, 2006 15:52
minutes - Guest appearances, expressions of thanks, future plans, and
Web 2.0 Resources,

> ¥Yodcast #1 (Posted on the FD Blog) Movember 23, 2006 1:47 minutes - —
A short demonstration for students on looking up grades at SCCC.
Created with Camtasia Studio 4.

> Podcast #30 (Posted on the FD Blog) Novernber 14, 2006 5:52 minutes
- Announcements, Facing Facebook and Other Social Metworking
Technaologies, Gizmo Project, and Kayak,

> Podcast #29 (Posted on the FD Blog) Movernber 7, 2006 6:35 minutes -
Announcements, new features in Camtasia Studio 4, and "Universal
Design."

> Podcast #28 (Posted on the FD Blog) October 31, 2006 5:57 minutes -
Announcements and some provocative ideas from The Fischbaowl,

> Podcast #27 (Posted on the FD Blog) October 24, 2006 2:24 minutes -
Created during my podcasting session with some audience participation,

> Poscast #26 (Posted on the FD Blog) October 17, 2006 6:21 minutes -
Announcements and some new free and easy to use technology for your

: classes,

< | >

Dane

© 2002 - 2008,
Seattle Community Colleges
Farulty Developrment

Send comrents & questions
o fd@scod. chc.edu

Faculty Development
Committee & Staff

|£

2. Create a blog and use it for distributing your podcasts. See below:

T 111 Padeasts from Narth Seatthe Community Collage: Januasy 2008 - Windows Internet Explacer =5[]
& - Drupyietit bogspoteom/2008_01 01 _srchwebeml = =2l 1% ol
B Edt Yew Favontes Toos Help

£ o ENIT 101 Podcasts from Morth Seatts C, Bp- @ - & - [FPage~ {3 Toks =

IT 111 151 Wieek § Poddcast
Podcasts T e L
from North | et
Seattle
Community
College

| [ & @ [ntemet R L
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3. Use a podcast hosting service like PodOMatic (http://www.podomatic.com)
or LibSyn.com (http://libsyn.com). See below:

J libsyn /I podcasting made easy - Mozilla Firefox g@@
File Edit Yiew History Bookmarks Tools Help delicio.us
&:: - - @ I_/:_T EE 1A g httpef flibsyn. comjdirectary fPrum_results=100 | ¥ | [B ' b
A
g podcasting made easy

What's going on libsyn?

Here are the| 100 ~ | most recent episodes published * This month's hott topics.
Family Worship Center's Podcast a action adventure age and as
GUI"V as Sin band titie PIg tock books british
i Play Audio i
iThis sermon was preached by Rev. Edward E. Cantu on business Camardella
E August 19, 2007 Wisit our wabsite at catholic chris christian christianity

od i farnilyworshipoenter. info )
Published on: 2007-08-18 23:18:00 church Comedy comic

credit crime detective

Subscribe: [[@))  tures| | I RSS
drama daramatic
>

Done

Making your podcast subscribable — RSS Feeds

RSS feeds are special control files that are updated each time you produce a
new podcast. They can be created in a variety of ways: written by hand
using a text editor (e.g., Notepad or TextEdit), with software that is free
(e.g., ListGarden) or low cost (e.g., FeedForAll), or using a web-based feed
burning service (e.g., FeedBurner.com).

Feedburner.com is the easiest way to create a feed and offers the most
features so we’ll be using Feedburner in this workshop.

FeedBurner (http://www.feedburner.com)

FeedBurner works great with Blogger to create a feed for your podcast. If you
haven’t created a blog, use the Blogger Quick Start instructions in the Blog
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section of the workshop notebook to set one up. Return to these instructions

after your blog is set up.
Here are the steps for using FeedBurner:

1. Copy your blog URL to the clipboard.

2. Open a new browser tab and go to http://www.feedburner.com.

3. Copy the blog URL into the Start FeedBurning Now box. Click in thelam a
podcaster box then click Next >>. See figure below.

¥ou are ol signed in (Sign n or Register) « Langusges = Heig

Hello, our name is FeedBurner.

Welcome to FreeBurmer! Get PRO features gratis.

Blogs » Podcasts » Commercial »
Fromote conent buskd & Track your subscribable Join Wall Street Jowmal. IS4
megsie audience, make 5 audio & vides conbent TODAY, Hewsweek, elc

Blog & Feed Advertising Programs =
See why brands like BlackBerry £ Verton choose FeedBuimer bor =!|ﬂ-g and RES Ed‘dﬂjglﬂg

Start FeedBurning Mow. Type your feed or blog URL below. (Why Burn?)

Learm how 1o burn your Blogger, TypePad WaordPress, MySpace of podcasividen feed

| http:Hipodcasting-for-educators blogspot comy ] 1 am a podcaster!

Curently feeding 846,311 publishers who've bumed 1,507,066 feads (== of 28 Mar 08). Mara »

4. In the Identify Feed Source window, click the radio button for the RSS feed
option then click Next >>. See figure on next page.
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[& FeedBurner-

Identify Feed Source

The feed URL you enfered is
http://podcasting-for-educators.blogspot.com/

FeedBumer discovered more than one feed at that address. Please select
one o use &5 your sounce:

() Podcasting for Educators - RSS: hiipipodeasting-for-
educators blogspot comieedsipostaidelaun? ali=rss

5. The Welcome page will appear. Make a note of the Feed Address on the

Accounts Cheat Sheet in the workshop notebook.

6. Create your FeedBurner account. Make a note of your username and
password on the Accounts Cheat Sheet. then press the Activate Feed >>

button. See figure below:

Give your feed its title and feedburner.com address.

Feed Title: | Podcasting for Educators

Enter o tithe to help identify your new feed in your account

Feed Address: hitp:/ffeeds feedburner com/blogspot/pDKN

The address above is where people can find your new feed

Create an account to claim your feed (or sign in if you already have one).

Username: |;‘Kent
Uze alhanumeric characters (-, _al'ld | are l:lkaj" taa)

Password: | sanseae

Passwond
{again): | (T}

Email Address: |jkent@s:cu ctc.edu

Activate Feed » | Gancel and go not ackvate
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7. A “Congrats” page appears. Click the Next >> button at the bottom of the
screen.

8. The next screen allows you to configure your feed for iTunes. Since so many
students have iPods and use iTunes, it’s very important to complete the
iTunes information. An example is provided on the next page.

a. Select a Category. Yours will probably be Education.
b. Select a Subcategory. Yours will probably be Higher Education.
c. If you have a course logo or even a college logo, you can enter the

URL for the image in the Podcast image location box. If you don’t

have a podcast image, leave this blank.

Give your podcast a subtitle.

Enter a description of your podcast in the next box.

Add keywords separated by commas in the next box.

Type in your email address in the next box.

Make sure there is a check in the Include “Media RSS” information

Sm 0o

and add podcast to Yahoo! Search box.
Add a copyright message. | use Copyright Jean Kent. All rights

reserved.
j. Enter your name in the Podcast author box.
k. Click the Next >> button
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include iTunes podcasting elements

Category; | Education * | » Subcategory
Higher Education ¥

Use additional categories +

Podcastimage location

Preview Image

Podcast subtitle

Creating Effective Educational Podcasts

Podcast summary

This podcast will support a workshop on educational
podcasting for community and technical college faculty.

Podcast search keywords:

podcasting, instructional technology, community college
technical college

Podcast author email address
jkent@scod ctc.edu

Include "Media RS5" information and add podcast to Yahoo! Search

Contains explicit content: | No vl i ]

Copyright message: | Copyright Jean Kent. All rights reserved

Podcast author: |Jean kent

« Back Next »

9. Feedburner will keep track of the number of times your podcasts are
downloaded. In the next screen, click in the box next to Item enclosure
downloads then click the Next >> button.

10.Single click on the Blogger Tab in your browser to return to your blog. Go to
the Settings tab and the Site Feed section. Copy the FeedBurner Feed
Address in the Post Feed Redirect URL box. Click on Save Settings. See the
figure on the next page.
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Basic | Publishing | Formatting | Comments | Archiving | SiteFeed | Email | OpenD | Permissics

Allowr Blog Feeds Full =

Selact Full to syndicate the full content of your post. Select Short if you only
wish to syndicate the first paragraph, or approximatedy 255 characters,
whichewvar is shorter, This setting will be applied to ¢ach type of feed (Post,

comment and per-post comment feed).

Post Feed Redirect URL

http-iifeeds. feedbumer comiblogspot/pOKN

hET SErviCE I
process your feed, enter the full feed URL here. Blogger will redirect all post

feed traffic to this address.

Post Feed Footer

This will appear after each post in your post feed, If you use ads or other third-
party feed additions, you can enter that code here. You must also set "Enable
Post Pages™ to "ves™ (in Archiving settimgs) and set “Allow Blog Feeds” to

“Full® {above).

Save Seftings

Your FeedBurner Feed Address will start with

http://feeds.feedburner.com/ with some unique characters added on to
the end. If you copied your Feed Address to the Accounts Cheat Sheet, copy
it from there.

11.Single click on the Feedburner Tab in your browser to return to FeedBurner.
Click on the Publicize tab then on the link labeled friendly graphic in the
section on making it easy to subscribe to your podcast. This takes you to
the Chicklet Chooser.

12.1 recommend you use the large orange RSS reader icon that is preselected
for you. It looks like this: E\]
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13.Scroll to the bottom of the page and select Blogger from the drop down list
labeled Use as a widget in then click the Go! button. See the figure below.

Use as a widget in [5) | Blogger v| Go!

Blogs » Podcasts « Commercial Publications » Advertising
About FeedBurner » Feed 101 » Prezs » Developers « Contact Us * Ping
Cur Bleg * Qur Podcast * Publisher Buzz » Publizher Tips

Privacy Policy » Terms of Service + Site Map « @2004-2008 FeedBurner, Inc.

14.Your blogger account will open in a new browser window. Click the ADD

WIDGET button. See figure below:

Add Page Element

Youre about to add content from anather site bo your blog. Make sure
you trust this site before proceeding. This action will place some code
from the content provider into your blog page. You can view the codse

details befaw.
Select a blog:
Title:
3

Edit Content:

Podeasting for Educatars »

Subscribe Now: Feed lcon

15.Your blog opens with the Layout tab selected. Click the orange SAVE
button. When you click on the View Blog link you’ll see the new RSS icon
(Chicklet) has been added to your blog.

16.Congratulations! You’ve successfully added a RSS feed to your podcast that

will be automatically updated each

time you post another podcast link in

your blog. You can return to FeedBurner to view user statistics, too.
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